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PREFACE

Every effort has been made to ensure that the information in this document is complete,
accurate, and up-to-date. The manufacturer assumes no responsibility for the results of
errors beyond its control. The manufacturer also cannot guarantee that changes in software
and equipment made by other manufacturers and referred to in this guide will not affect
the applicability of the information in it. Mention of software products manufactured by
other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful
as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or
completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:
www.okiprintingsolutions.com
Copyright © 2009 Oki Europe Ltd. All rights reserved.

Oki, Oki Printing Solutions and Microline are registered trademarks of Oki Electric Industry
Company, Ltd.

Hewlett-Packard, HP, and Laserlet are registered trademarks of Hewlett-Packard
Company.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.
ENERGY STAR is a trademark of the United States Environmental Protection Agency.
Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their
proprietors.

As an ENERGY STAR Program Participant, the manufacturer has determined
W that this product meets the ENERGY STAR guidelines for energy efficiency.
™

This product complies with the requirements of the Council Directives

c € 2004/108/EC (EMC) and 2006/95/EC (LVD) as amended where applicable, on

the approximation of the laws of the member states relating to
electromagnetic compatibility, low voltage.
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EMERGENCY FIRST AID

Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical

o attention.
If it gets into the eyes, flush with large amounts of water for at least 15
minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of
staining skin or clothing.

MANUFACTURER

Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,

Japan

IMPORTER TO THE EU/AUTHORISED REPRESENTATIVE

Oki Europe Limited (trading as OKI Printing Solutions)
Blays House

Wick Road

Egham

Surrey TW20 0OHJ

United Kingdom

For all sales, support and general enquiries contact your local distributor.

ENVIRONMENTAL INFORMATION

ntingsoy,
fﬁﬂ‘ %,,!.%
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NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!

A caution provides additional information which, if ignored, may
result in equipment malfunction or damage.

A warning provides additional information which, if ignored, may
result in a risk of personal injury.

For the protection of your product, and in order to ensure that you benefit from its full
functionality, this model has been designed to operate only with genuine original toner
cartridges. Any other toner cartridge may not operate at all, even if it is described as
“compatible”, and if it does work, your product's performance and print quality may be
degraded.

Specifications subject to change without notice. All trademarks acknowledged.
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INTRODUCTION

Congratulations on purchasing this monochrome page printer.

Your new printer is designed with a range of advanced features to give you crisp black and
white pages at high speed on a wide range of print media.

For your information, a summary of the main features of your printer is given below.

PRINTER FEATURES

> Five different models to choose from: B410d, B410dn, B430d, B430dn, B440dn
(d denotes Duplex included and n denotes Network Interface Card included).

> Memory: 32MB for B410d, B410dn; 64MB for B430d, B430dn and B440dn.
> High speed printing: 28ppm A4 and 30ppm Letter.

> Resolution: 1200 x 600 dpi for B410d, B410dn; 1200 x 1200 dpi for B430d, B430dn
and B440dn.

> Paper handling: 250 sheets (75g/m?2) for B410d, B410dn, B430d, B430dn and 530
sheets (75g/m?2) for B440dn.

> Emulation: standard Printer Control Language PCL5e, PCLXL, Epson FX, IBM
ProPrinter and PostScript 3 for B430d, B430dn and B440dn.

> Barcodes: embedded for SIDM emulations.

> Flash DIMM: 0.5MB for B410d, B410dn and 5MB for B430d, B430dn, B440dn to
allow the storage of additional fonts or bar codes.

> USB 2.0 High speed and Parallel interfaces.

> 10/100 BASE-TX Network: standard for B410dn, B430dn and B440dn, lets you share
this valuable resource among users on your office network.

> Multi Purpose tray for B430d, B430dn and B440dn: to extend the range of media
your printer can accommodate (capacity 50 sheets (64g/m2) or 10 envelopes), and
can also use as manual duplex.

> Manual Feed tray for B410d, B410dn: to feed single sheets, heavy paper stocks,
envelopes, other special media and can also use as manual duplex for B410d,
B410dn.

> “Ask Oki” - a user-friendly function that gives a direct link from your printer driver
screen (but not illustrated in this guide) to a dedicated web site specific to the exact
model you are using. This is where you’ll find all the advice, assistance and support
you could need to help you get the best possible results from your Oki printer.

Additionally, the following optional features are also available:

> 32, 64, 128, 256MB RAM DIMM: to extend the main memory of your printer and
speed up the processing of large files

> Second paper tray: to increase your printer’s paper handling capacity by 530 sheets
(75g/m?2).

USING YOUR PRINTER

To help you get the most from your printer, the manufacturer has provided a variety of
supporting materials. A summary of these materials and their purposes is given in the
following chapter.
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ABOUT THIS MANUAL

This manual is the user’s guide (check the Oki Printing Solutions website,
www.okiprintingsolutions.com, for the most up-to-date version) for your printer and forms
part of the overall user support listed below:

> Quick Set-up Guide: to describe how to unpack, connect and power up your
printer.

> This User’s Guide: to help you to operate your printer and make the best use of its
many features. Also included are guidelines for troubleshooting and maintenance to
ensure that it performs at its best. Additionally, information is provided for adding
optional accessories as your printing needs evolve.

> Installation Guides: accompany consumable items and optional accessories to
describe how to install them.

> Online Help: online information associated with the printer driver and Status
Monitor software.

This manual has been written using more than one printer as a model and the illustrations/
screenshots reflect this. What you see will be appropriate to the model you are using.

ONLINE USAGE

This manual is intended to be read on screen using an Adobe Acrobat Reader. Use the
navigation and viewing tools provided in Acrobat.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of
interest to jump to the required topic. (If the bookmarks are not available, use the
Table of Contents.)

> In the list of bookmarks click on Index to jump to the Index. (If the bookmarks are
not available, use the Table of Contents.) Find the term of interest in the
alphabetically arranged index and click on the associated page number to jump to
the page containing the subject.

PRINTING PAGES

The whole manual, Individual pages, or sections may be printed. The procedure is:
1. From the toolbar, select File > Print (or press the Ctrl + P keys).
2. Choose which pages you wish to print:

(a) All pages, for the entire manual.

(b) Current page for the page at which you are looking.

Print [x]

tore (A | | Conies

Status:  Ready
Type:

Where:  LPTI
- PrintRang

& Al226 pages €1 EeE i prgE= Braphis
© Cunrent page

€ Pages from:[1 to: [e26
Print [Even and Odd Pages =

¥ Comments

[ PostSeript Op Preview k—8.25—1

PrintMethod:  [Language Level 3 <
eei

11,68]

jan Fants I™ Save Printer Memony

ColorManaged: O printer

Units: Inches  Zoorm: 141.4%

Printing Tips | [ Advanced. Cancel

About this manual > 8



(c) Pages from and to for the range of pages you specify by entering their page
numbers.

3. Click OK.

ABBREVIATIONS USED

The following abbreviations are used in this manual:

ABBREVIATION MEANING

Ctrl Control

dpi dots per inch

DIMM Dual In-line Memory Module
d duplex

n network card installed
LED Light Emitting Diode

NIC Network Interface Card
PCL Printer Control Language
PS PostScript (emulation)
PSE PostScript Emulation
RAM Random Access Memory
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PRINTER COMPONENTS

Apart from the Operator panels, which are described in the next chapter, the B410d,
B410dn, B430d, B430dn, and B440dn printers look similar from the outside. The important
components are identified in the representations below.

Operator panel (B430dn shown)
Output Stacker (150 sheets, face down)

Output Stacker extension
Top cover release button

Multi Purpose Tray (only for B430d, B430dn and B440dn; 50 sheets)(shown in open
position)

uipwNR

o

Multi Purpose Tray extension

7. Paper Tray (250 sheets for B410d, B410dn, B430d, B430dn and 530 sheets for
B440dn)

8. Paper Tray level indicator
9. ON/OFF switch

10. Rear Output cover

11. LED array

12. Image drum

13. Manual Feed Tray (only for B410d, B410dn; single sheet feed) (shown in open
position)

14. Toner cartridge
15. Fuser unit

16. Top cover
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17.
18.
19.
20.
21.
22.
23.
24.

20— 8 |—
21
22
\ LL———'— _J

Power cable connection

Duplex unit

Parallel interface connection

USB interface connection

LAN interface connection (only for B410dn, B430dn and B440dn)
Test button (only for B410dn, B430dn and B440dn)

Memory panel (to upgrade your printer’'s memory RAM DIMM)
Cooling fan
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OPERATOR PANELS

This chapter describes the function of the operator panel on your printer. It is useful to
describe the Printer Menu Setup Tool at this point as it provides the B410d, B410dn, the
equivalent of the menu control panel on the B430d, B430dn and B440dn (See “Printer
drivers” on page 38 for installation of the Printer Menu Setup Tool.)

B410p, B410DN

OPERATOR PANEL

The B410d, B410dn operator panel consists of 2 indicating LEDs, an LCD (3) and an Online
(4) button. The LEDs indicate Ready (1) and Attention (2).

1 3 4
READY _
® | ON[Line
. 1 )
ATTENTION 7 3

) = v

T

2

LED INDICATORS

The LED indicators show the status of the printer and have three operating conditions as
follows:

> Indicator off

> Indicator on

> Flash

Both LED indicators come on momentarily when power is switched on using the main power
switch.

Ready LED (green)

> Indicator on - the printer is on-line and ready to receive data.

> Indicator off - the printer is off-line and cannot receive data.

Attention LED (red)
> Indicator on - this indicates a warning, (e.g. low toner).
> Indicator off - this indicates normal condition.

The meaning of the indicator LEDs when they flash (x) is summarised as follows:

NOTE
The table below is also applicable for the B430 and B440 models.
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FLASH TYPE READY LED (1) ATTENTION LED (2) MEANING

Flash X The printer is receiving
and processing data
during printing or the
printer is resetting.

X There is a printing error,
for example, a problem
with paper, the cover is
open or the paper tray is
empty while a job is
processing.

X X There is a minor error
with the printer, for
example, toner is low
and the image drum
needs to be changed.

LCD

The LCD (3) has two rows of up to 16 alphanumeric digits, displaying print status and error
messages.

ONLINE BUTTON

The primary functions of the Online button (4) are activated by pressing the switch
momentarily and releasing. The primary functions are as follows:

> Turning the printer off-line.

> Turning the printer on-line (ready).

> Resuming printing after page overflow.

> Interrupting data processing when the printer is receiving and processing data.
> Resuming data processing.

The secondary functions of the Online button are activated after turning the printer off line,
then pressing and holding the switch for four seconds before releasing. The secondary
functions are as follows:

> Printing the demo and menu pages.

NOTE
Demo and menu pages can also be printed using the printer’s Printer Menu
Setup Tool.

> Printing any data held in the buffer after printing has been cancelled.

The other functions of the Online button are activated after turning the printer off line then
pressing and holding the switch for seven seconds before releasing. The other functions are
as follows:

> Printing a cleaning page.

NOTE
A cleaning page can also be printed using the printer’s Printer Menu Setup tool.
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> Resetting the printer and clearing the buffer after printing has been cancelled.

NOTE

To reset the printer to the default settings of the manufacturer, the Online
button is pressed and held down while the printer is switched on with the main
power switch. The LED indicators blink when the printer has reset to the
default settings.

CHANGING LANGUAGE

The default language used by your printer for display messages and for report printing is
English. If required, this can be changed to:

German Danish
French Dutch
Italian Turkish
Spanish Portuguese
Swedish Polish
Russian Greek
Finnish Czech
Hungarian Norwegian

NOTE

1. The Operator Panel Language Setup Wizard will run automatically when
you install the printer driver. Follow the instructions provided by this
utility to set your chosen language.

2. The list above is neither conclusive nor exhaustive.

PRINTER MENU SETUP TOOL

After installing the printer driver software onto your computer, the Printer Menu Setup Tool
is then automatically installed. See “Printer drivers” on page 38. This Printer Menu Setup
Tool is used to control and change the various printer settings.

Using the Printer Menu Setup Tool
Viewing or changing the printer settings are carried out as follows:

Click on Start > All Programs > Okidata > Printer Menu Setup Tool and select the
Printer Menu Setup Tool.
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MENU FUNCTIONS

The Printer Menu allows you to view and change the printer’s internal settings. You can

think of this as the software equivalent of the LCD operator panel.

The settings are grouped into categories or *menus” such as Information Menu or Print

Menu.

Some of these settings are similar to those found in your printer driver or application
software. The settings that you can change using this software act as the printer’s defaults.

These can be overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer Menu settings to one, this
will be overridden if you select three copies of your document in the printer driver.

Information menu

This menu provides a quick method of listing various items stored within the printer.

Setup Display  Help

e 7

Information Menu

Print Menu

Media Menu

Syskem configuration Menu
FCL Meru

[+ PPR. Menu

Fix Menu

Parallel Menu

UISE Menu

Metwiork Menu
Maintenance Menu

Usage Meru

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE

NETWORK EXECUTE B410dn only

PRINT FILE LIST EXECUTE

PRINT PCL FONT EXECUTE

PRINT PPR FONT EXECUTE

PRINT FX FONT EXECUTE

DEMO1 EXECUTE

PRINT ERROR LOG EXECUTE

USAGE REPORT EXECUTE Is displayed only when
‘USAGE REPORT' is
enabled in the Print
Statistics Menu
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Print menu

This menu provides adjustment of various print job related functions.

ITEM DEFAULT REMARKS
COPIES 1

DUPLEX OFF
MANUAL OFF
PAPER FEED TRAY1
AUTO TRAY SWITCH ON

TRAY SEQUENCE DOWN
MEDIA CHECK ENABLE
RESOLUTION 600DPI
TONER SAVE MODE DISABLE
ORIENTATION PORTRAIT
LINES PER PAGE 64 LINES

EDIT SIZE

CASSETTE SIZE

Media menu

This menu provides adjustment to suit a wide range of print media.

ITEM DEFAULT REMARKS

TRAY1 PAPERSIZE A4

TRAY1 MEDIATYPE PLAIN

TRAY1 MEDIAWEIGHT MEDIUM

TRAY2 PAPERSIZE A4 When Tray?2 is installed
TRAY2 MEDIATYPE PLAIN When Tray?2 is installed
TRAY2 MEDIAWEIGHT MEDIUM When Tray2 is installed
MN PAPERSIZE A4

MN MEDIATYPE PLAIN

MN MEDIAWEIGHT MEDIUM

UNIT OF MEASURE MILLIMETER

X DIMENSION

210 MILLIMETER

Y DIMENSION

297 MILLIMETER
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System configuration menu

This menu adjusts general printer settings to suit the way you prefer to work.

ITEM DEFAULT REMARKS
POW SAVE TIME 1 MIN

PERSONALITY AUTO EMULATION

CLRABLE WARNING ONLINE

AUTO CONTINUE ON

MANUAL TIMEOUT 60 SEC

TIMEOUT INJOB 40 SEC

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC B410dn only
LOW TONER CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

PCL Emulation

This menu controls the printer’s PCL emulation.

ITEM DEFAULT REMARKS
FONT SOURCE RESIDENT

FONT NO. 10

FONT PITCH 10.00 CPI

SYMBOL SET PC-8

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

TRAY ID#

PCL MNID 2

PCL TOID 4

PCL T1ID 1

PCL T2ID 5 When Tray2 is installed
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PPR Emulation

This menu controls the printer’s PPR emulation.

ITEM DEFAULT REMARKS
CHARACTER PITCH 10 CPI
FONT CONDENSE 12CPI TO 20CPI
CHARACTER SET SET-2
SYMBOL SET IBM-437
LETTER O STYLE DISABLE
ZERO CHARACTER NORMAL
LINE PITCH 6 LPI
WHITE PAGE SKIP OFF
CR FUNCTION CR
LF FUNCTION LF
LINE LENGTH 80 COLUMN
FORM LENGTH 11.7 INCH
TOF POSITION 0.0 INCH
LEFT MARGIN 0.0 INCH
FIT TO LETTER DISABLE
TEXT HEIGHT SAME
FX Emulation

This menu controls the printer’'s FX emulation.

ITEM DEFAULT REMARKS
CHARACTER PITCH 10 CPI
CHARACTER SET SET-2
SYMBOL SET IBM-437
LETTER O STYLE DISABLE
ZERO CHARACTER NORMAL
LINE PITCH 6 LPI
WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN
FORM LENGTH 11.7 INCH
TOF POSITION 0.0 INCH
LEFT MARGIN 0.0 INCH
FIT TO LETTER DISABLE
TEXT HEIGHT SAME
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Parallel menu

This menu controls the operation of the printer’s parallel data interface.

ITEM DEFAULT REMARKS
PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME 3 MICRO SEC

USB menu

This menu controls the operation of the printer’s USB data interface.

ITEM DEFAULT REMARKS
usB ENABLE

SOFT RESET ENABLE

SPEED 480 Mbps

SERIAL NUMBER ENABLE

Network menu

This menu controls the operation of the printer’'s 10Base-T/100Base-TX network interface.

NOTE

This is applicable only to the B410dn model.

ITEM DEFAULT REMARKS
TCP/IP ENABLE

IP VERSION IPv4

NETBEUI ENABLE

NETWARE ENABLE

ETHERTALK ENABLE

FRAMETYPE AUTO

IP ADDRESS SET AUTO

IP ADDRESS

XXX, XXX XXX XXX

SUBNET MASK

XXX, XXX XXX XXX

GATEWAY ADDRESS

XXX, XXX XXX XXX

WEB ENABLE
TELNET DISABLE
FTP DISABLE
SNMP ENABLE
NETWORK SCALE NORMAL
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ITEM DEFAULT REMARKS

HUB LINK SETTING AUTO NEGOTIATE

FACTORY DEFAULTS EXECUTE

Print Statistics menu

This menu provides information on the number of A4/Letter pages printed and allows you
to reset the counter.

ITEM DEFAULT REMARKS

USAGE REPORT ENABLE

RESET COUNTER EXECUTE

GROUP COUNTER DISABLE

CHANGE PASSWORD Enter the new password

Maintenance menu

This menu provides access to various printer maintenance functions.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE

SAVE MENU EXECUTE

POWER SAVE ENABLE

PAPER BLACK SET 0

DARKNESS 0

CLEANING EXECUTE

RESTORE MENU EXECUTE Displayed in Menu when
Menu settings have been
stored.

Usage menu

This menu is for information only, and provides an indication of total usage of the printer
and the expected life left in its consumable items. This is particularly useful if you do not
have a full set of replacement consumables to hand and you need to know how soon you
will need them.

ITEM DEFAULT REMARKS

DRUM LIFE REMAINING% An indication of the
remaining drum life.

TONER REMAINING% An indication of how
much toner is left in the
cartridge.
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PRINTING MENU SETTINGS

The menu settings can be printed as a menu map as follows.

Using the Online button
1. Press the Online button to take the printer off-line.

2. Press and hold down the Online button for at least four seconds, but less than
seven seconds.

3. The printer prints a list of the menu settings and a demo print page. See “Online
button” on page 13.

Using the Printer Menu Setup Tool

1. Select Start > All Programs > Okidata > Printer Menu Setup Tool.
The Printer Menu is displayed.

2. Expand the Information Menu.

3. To print a demo page or Menu Map, select either Demo1 or Print Menu Map and
click Execute.

Operator panels > 21



B430Dp, B430DN, B440DN
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OPERATOR PANEL

The B430d, B430dn, B440dn operator panel consists of a menu driven control panel, an
LCD display and two LED indicators.

PANEL ELEMENTS

1.

Liquid crystal display. (LCD) panel. Two rows of up to 16 alphanumeric digits
displaying print status, menu items in menu mode and error messages.

Menu Scroll Buttons. Press briefly to enter the MENU mode. Press briefly again to
select the next menu. Press for more than 2 seconds to scroll through the different
menus.

Back button. Press briefly to return to the previous higher level menu item or exit
the menu when in MENU mode.

Enter button. In the ONLINE or OFFLINE mode: press this briefly to enter the MENU
mode. In the MENU mode: press this briefly to select the menu or setting indicated on
the LCD.

NOTE
When pressed with DATA displayed (press and hold for five seconds), it forces
the printer to print out the remaining data in the printer.

Online button. Press to switch between ONLINE and OFFLINE status.
Press to exit the menu and displays ONLINE, when in the MENU mode.

NOTE

When pressed in Menu mode, the Online button returns the printer to ONLINE
status. Also when there is an error indicating wrong paper size, pressing the
Online button forces the printer to print.

Cancel button. When printing press to cancel a print job. Press to exit the MENU
mode and go ONLINE, when in the MENU mode.

Ready indicator (green). ON indicates ready to receive data. FLASHING
indicates processing data. OFF indicates Offline.

Attention indicator (red). ON indicates a warning (e.g. low toner). FLASHING
indicates an error, (e.g. toner empty). OFF indicates normal condition.
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MENU FUNCTIONS
The Printer Menu allows you to view and change the printer’s internal settings.

The settings are grouped into categories or "*menus” such as Information Menu or Print
Menu.

Some of these settings are similar to those found in your printer driver or application
software. The settings that you can change using this software act as the printer’s defaults.
These can be overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer Menu settings to one, this
will be overridden if you select three copies of your document in the printer driver.

Factory default settings are shown in the following tables.

Information menu

This menu provides a quick method of listing various items stored within the printer.

ITEM ACTION REMARKS

PRINT MENU MAP EXECUTE

NETWORK EXECUTE B430dn and B440dn only

PRINT FILE LIST EXECUTE

PRINT PCL FONT EXECUTE

PRINT PSE FONT EXECUTE

PRINT PPR FONT EXECUTE

PRINT FX FONT EXECUTE

DEMO 1 EXECUTE

PRINT ERROR LOG EXECUTE

USAGE REPORT EXECUTE Is displayed only when
‘USAGE REPORT' is
enabled in the Print
Statistics Menu

Shutdown menu

This menu shuts down the printer.

ACTION REMARKS

SHUTDOWN START EXECUTE

Print menu

This menu provides adjustment of various print job related functions.

ITEM DEFAULT REMARKS
COPIES 1

DUPLEX OFF

PAPER FEED TRAY1

AUTO TRAY SWITCH ON

TRAY SEQUENCE DOWN
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ITEM DEFAULT REMARKS
MP TRAY USAGE DO NOT USE

MEDIA CHECK ENABLE

RESOLUTION 1200DPI

TONER SAVE MODE DISABLE

ORIENTATION PORTRAIT

LINES PER PAGE 64 LINES

EDIT SIZE

CASSETTE SIZE

Media Menu

This menu provides adjustment to suit a wide range of print media.

ITEM DEFAULT REMARKS

TRAY 1 PAPERSIZE A4

TRAY 1 MEDIATYPE PLAIN

TRAY 1 MEDIAWEIGHT MEDIUM

TRAY2 PAPERSIZE A4 When tray 2 is installed
TRAY2 MEDIATYPE PLAIN When tray 2 is installed
TRAY2 MEDIAWEIGHT MEDIUM When tray 2 is installed
MPT PAPERSIZE A4

MPT MEDIATYPE PLAIN

MPT MEDIAWEIGHT MEDIUM

UNIT OF MEASURE MILLIMETER

X DIMENSION

210 MILLIMETER

Y DIMENSION

297 MILLIMETER

System configuration menu

This menu adjusts general printer settings to suit the way you prefer to work.

ITEM

POW SAVE TIME

DEFAULT

1 MIN

REMARKS

PERSONALITY AUTO EMULATION

PARA PS-PROTOCOL ASCII

USB PS-PROTOCOL RAW

NET PS-PROTOCOL RAW B430dn and B440dn
only

CLRABLE WARNING ONLINE

AUTO CONTINUE OFF

MANUAL TIMEOUT 60 SEC

TIMEOUT INJOB 40 SEC
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ITEM DEFAULT REMARKS

TIMEOUT LOCAL 40 SEC

TIMEOUT NET 90 SEC B430dn and B440dn
only

LOW TONER CONTINUE

JAM RECOVERY ON

ERROR REPORT OFF

START UP OFF

PCL emulation

This menu controls the printer’s PCL emulation.

ITEM DEFAULT REMARKS

FONT SOURCE RESIDENT

FONT NO. 10

FONT PITCH 10.00 CPI

SYMBOL SET PC-8

A4 PRINT WIDTH 78 COLUMN

WHITE PAGE SKIP OFF

CR FUNCTION CR

LF FUNCTION LF

PRINT MARGIN NORMAL

PEN WIDTH ADJUST ON

TRAY ID#

PCL TOID 4

PCL T1ID 1

PCL T2ID 5 When Tray2 is installed
PPR Emulation

This menu controls the printer’'s PPR emulation.

ITEM

CHARACTER PITCH

DEFAULT

10 CPI

REMARKS

FONT CONDENSE

12 CPI to 20 CPI

CHARACTER SET SET-2
SYMBOL SET IBM-437
LETTER O STYLE DISABLE
ZERO CHARACTER NORMAL
LINE PITCH 6 LPI
WHITE PAGE SKIP OFF
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ITEM DEFAULT REMARKS

CR FUNCTION CR
LF FUNCTION LF
LINE LENGTH 80 COLUMN
FORM LENGTH 11.7 INCH
TOF POSITION 0.0 INCH
LEFT MARGIN 0.0 INCH
FIT TO LETTER DISABLE
TEXT HEIGHT SAME

FX Emulation

This menu controls the printer’s FX emulation.

ITEM DEFAULT REMARKS
CHARACTER PITCH 10 CPI
CHARACTER SET SET-2
SYMBOL SET IBM-437
LETTER O STYLE DISABLE
ZERO CHARACTER NORMAL
LINE PITCH 6 LPI
WHITE PAGE SKIP OFF

CR FUNCTION CR

LINE LENGTH 80 COLUMN
FORM LENGTH 11.7 INCH
TOF POSITION 0.0 INCH
LEFT MARGIN 0.0 INCH
FIT TO LETTER DISABLE
TEXT HEIGHT SAME

Parallel menu

This menu controls the operation of the printer’s parallel data interface.

ITEM DEFAULT REMARKS
PARALLEL ENABLE

BI-DIRECTION ENABLE

ECP ENABLE

ACK WIDTH NARROW

ACK/BUSY TIMING ACK IN BUSY

I-PRIME DISABLE

OFFLINE RECEIVE DISABLE
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USB menu

This menu controls the operation of the printer’s USB data interface.

ITEM DEFAULT REMARKS
usB ENABLE

SOFT RESET DISABLE

SPEED 480Mbps

OFFLINE RECEIVE DISABLE

SERIAL NUMBER ENABLE

Network menu

This menu controls the operation of the printer’'s 10Base-T/100Base-TX network interface.

NOTE
This is applicable only to the B430dn and B440dn models.

ITEM DEFAULT REMARKS
TCP/IP ENABLE

IP VERSION IPv4

NETBEUI ENABLE

NETWARE ENABLE

ETHERTALK ENABLE

FRAMETYPE AUTO

IP ADDRESS SET

AUTO

IP ADDRESS

XXX XXX XXX, XXX

SUBNET MASK

XXX XXX XXX XXX

GATEWAY ADDRESS XXX XXX XXX XXX
WEB ENABLE
TELNET DISABLE

FTP DISABLE

SNMP ENABLE
NETWORK SCALE NORMAL

HUB LINK SETTING

AUTO NEGOTIATE

FACTORY DEFAULTS

EXECUTE

Operator panels > 27




Print Statistics menu

This menu provides information on the number of A4/Letter pages printed and allows you
to reset the counter.

ITEM DEFAULT REMARKS

USAGE REPORT ENABLE

RESET COUNTER EXECUTE

GROUP COUNTER DISABLE

CHANGE PASSWORD Enter the new password.

Maintenance menu

This menu provides access to various printer maintenance functions.

ITEM DEFAULT REMARKS

MENU RESET EXECUTE

SAVE MENU EXECUTE

POWER SAVE ENABLE

PAPER BLACK SET 0

DARKNESS 0

CLEANING EXECUTE

RESTORE MENU EXECUTE Displayed in Menu when
Menu settings have been
stored.

Usage menu

This menu is for information only, and provides an indication of total usage of the printer
and the expected life left in its consumable items. This is particularly useful if you do not
have a full set of replacement consumables to hand and you need to know how soon you
will need them.

ITEM DEFAULT REMARKS

DRUM LIFE REMAINING% An indication of the
remaining drum life.

TONER REMAINING% An indication of how
much toner is left in the
cartridge.
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PRINTING MENU SETTINGS

Current menu settings can be confirmed by printing a Menu Map, using the control panel.

NOTE
This is applicable only to B430d, B430dn and B440dn models.

1. Press the Menu @ or @ button until the INFORMATION MENU is available, then

press @ button.

2. Press the @ or @ button until the display prompts you to print the menu map.
3. Press the @ button to print the menu map.

4. Press the Cancel or Online or the @ button repeatedly to exit the MENU mode.
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PAPER RECOMMENDATIONS

For guidance on the media you can use with your printer, which input tray and which
ejection method to use, see the section entitled “Paper and tray information” in the
“Specifications” chapter.

NOTE
The reference to Manual Feed Tray is for the B410d, B410dn models and the
Multi Purpose Tray is for the B430d, B430dn and B440dn models.

PAPER AND ENVELOPE TYPES

The manufacturer of this printer recommends the following guidelines when selecting paper
and envelopes for use in your printer:

> Paper and envelopes should be stored flat and away from moisture, direct sunlight
and heat sources.

> Use a smooth finished paper such as copier or laser type paper with a Sheffield
(smoothness) rating of 250 or less. If in doubt, please ask your paper supplier.

> Use paper and envelopes that are designed for use in laser type printers.

> The use of heavily laid or textured paper will seriously impact on the life of the
image drum.

> Do not use very smooth, shiny/glossy paper.

v

Do not use heavily embossed headed paper.

v

Do not use specially treated papers such as carbon paper, non-carbon paper, thermal
paper and impact paper.

Avoid using paper with perforations, cut-outs and ragged edges.
Do not use envelopes with windows or metal clasps.

Do not use envelopes with self sealing flaps.

V V V V

Avoid using damaged or curled envelopes.

TRANSPARENCIES AND ADHESIVE LABELS

The manufacturer of this printer recommends the following guidelines when selecting
transparencies and adhesive labels for use in your printer:

> Always manually feed single sheets using a Manual Feed Tray or Multi Purpose Tray.
> Always use rear output.

> Media must be designed for use in laser printers or photocopiers and must be able to
withstand 200°C for 0.1 sec.

> Do not use media designed for use in colour laser printers and photocopiers.
> Labels should cover entire carrier sheet.

> Carrier sheet or adhesive must not be exposed to any part of the printer.
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POSTCARDS

The manufacturer of this printer recommends the following guidelines when selecting
postcards for use in your printer:

> Always manually feed single postcards using the Manual Feed Tray or Multi Purpose
Tray, depending on your printer model.

Use unfolded double postcards.
Use postcards designed for use in laser type printers

Do not use postcards used for ink jet printers.

V V. V V

Do not use stamped or picture postcards.

INSTALLING PAPER

PAPER TRAY

NOTE

If you are topping up the paper in a paper tray, it is recommended that you
remove the remaining paper from the tray first then add the new paper stock
followed by the paper you removed. This ensures that the oldest paper is used
first to help prevent paper jams.

1. Remove the paper tray from the bottom of the printer and place plain paper (1) in
the tray, keeping the level of the paper in the tray below the paper full guide
arrowheads shown on the paper guides (2). For loading A4 or Legal size paper, push
the lever (4) in the arrow direction and extend the paper tray using the rear paper
support (5).

NOTE
Load letter headed paper face down and top edge towards the front of the
paper tray (3).
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2. Adjust the rear paper support (5) to the size of paper you are using by gripping the
lugs, tilting and sliding the support forwards or backwards as necessary.

3. Adjust the paper guides (5). It is important to adjust the paper guides correctly to
ensure that the paper is not skewed in the print process. Paper jams may occur if
this operation is not carried out correctly.

4. Replace the tray in the printer (7). The paper level indicator (8) provides a visual
indication of how much paper is left in the tray.

NOTE

If you have the optional second paper tray (Tray 2) and you are printing from
the first (upper) tray (Tray 1), you can pull out the second (lower) tray to
reload it. However, if printing from the second (lower) tray, do not pull out the
first (upper) tray as this will result in a paper jam.

Face up and face down printing

For face down printing, make sure the Rear cover is closed (the paper exits from the top
of the printer). The Output Stacker on the top of the printer stacks printed pages face down,
capacity 150 sheets of weight 75g/m2. Pages printed in reading order (page 1 first) will be
sorted in reading order (last page on top, facing down).

For face up printing, make sure the Rear cover is open. In this condition, paper will exit via
this path, regardless of driver settings.

Always use this tray in conjunction with the Manual Feed Tray, Multi Purpose Tray or for
heavyweight stocks to reduce the possibility of paper jams.

See “Paper and tray information” on page 78.

Automatic feed sequence

With no optional feed trays installed, the Autotray function in the Print Menu is set by
default to ON and the Tray sequence function is set to DOWN. In this way, if a tray runs
out of paper, automatic feed will take place in the order Tray 1, Tray 2 (if fitted), Multi
Purpose Tray or the Manual Feed Tray, provided that these trays are set up for identical
media. Also, configure the media size and media weight for the respective trays in the
operator panel or Printer Menu Setup tool, depending on your printer model.
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MULTI PURPOSE TRAY AND MANUAL FEED TRAY

1. B430/B440: Pull down the Multi Purpose Tray (1), fold out the paper supports (2),
and adjust the paper guides to the width of the paper (4).

B410: Pull down the Manual Feed Tray (1), and adjust the paper guides (2) to the
width of the paper.

B430 / B440

2. B430/B440: Load the paper into the Multi Purpose Tray and push the set button
(3). Ensure that the paper is loaded below the arrow level (5) to avoid paper jam.

NOTE
Do not exceed the paper capacity of approximately 50 sheets or 10 envelopes
depending on the media weight.

B410: Load single sheet at a time into the Manual Feed Tray.

B430 / B440

> For single-sided printing on headed paper load the paper with the pre-printed side
up and top edge into the printer.

> For two-sided (duplex) printing on headed paper, load the paper with the pre-
printed side down and top edge away from the printer.
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> Envelopes should be loaded flap down, face up with the top edge to the left and
short edge into the printer.

NOTE
Do not select Duplex printing on envelopes.

> Load Transparencies face up and top edge into the printer.

> For heavyweight paper or cardstock open the rear output cover to collect the
printed output. This will give the paper a nearly straight path through the
machine, avoiding paper jams and damage to the paper.

B430/B440: If required, set the media size and orientation in the media menu
using the control panel, then issue the print command.

B410: If required, set the media size and orientation in the Printer Menu Setup tool,
then issue the print command.

Damage to the printer may occur if the incorrect paper setting is
used when printing on a different media.

NOTE

> You can also set the media type in your printer driver. However, the
printer driver settings will override the settings on the control panel or
Printer Menu Setup Tool.

> Remember to reset the printer for normal paper after printing on a
different media.

PAPER FEED, SIZE AND MEDIA SETTING

The process used to fuse (fix) the printed image to the paper involves a mixture of pressure
and heat. Too much heat will cause lightweight paper to crease or curl and corrugations in
transparencies. Too little heat will cause the image not to fuse fully into heavyweight paper.

NOTE

Although media properties can be set in the printer driver for particular jobs,
when filling a tray with media it is recommended that you manually set the
printer to match the media as described here.

B410D, B410DN

You can change the media type as follows:

1.
2.
3.

4.

Start the Printer Menu Setup tool.
Click Media Menu.

Click on the paper tray being used. Adjust the media type to the required setting
and, if necessary, the paper size to the size of the paper being used.

Click on the Setup tab and click Apply the changed settings, then OK to set the
printer to the new media type.
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B430D, B430DN, B440DN

Using the control panel on your printer, you can choose:
> which paper to use

> the size of the paper you wish to use

> the weight of the paper (thickness)

> the type of paper

NOTE
> If the settings in the printer differ from those selected on your computer,
the printer will not print and the LCD will display an error message.

> The following printer settings are given as a guide only. Some software
applications require the paper feed, size and media settings to be selected
from within the application (page setup).

> Although media properties can be set in the printer driver for particular
jobs, it is recommended that when filling a tray with media you manually
set the printer to match the media as described here.

Paper feed selection

The paper feed, paper size, paper weight and media type can be set manually on the printer
using the control panel as follows.

1.  Press the Menu [ or {~) button repeatedly until PRINT MENU is displayed, then
press the @ button.

2. Pressthe [&} or {~) button until the required paper feed is displayed.
3. Press the @ button. An asterisk (*) appears next to the selected paper feed.

4, Press the Cancel or Online or the @ button repeatedly to exit the MENU mode

NOTE

When the AUTO TRAY SWITCH is set to ON and more than one paper tray is
fitted, paper feed automatically switches to the next available paper tray,
providing non-stop printing.

Paper size

Set the paper size as follows.

NOTE

> When using paper trays, standard paper sizes are recognised
automatically with CASSETTE SIZE (default setting) selected. Paper size
need only be set for custom paper sizes.

> When using the Multi Purpose Tray, the paper size has to be selected.

1. Press the Menu @ or @button until PRINT MENU is displayed, then press @
button.

2. Press either @ or @ button repeatedly until EDIT SIZzE is displayed, then press

@ button.
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3. Press either E or @ button until the required paper size is displayed, then press
the @ button. An asterisk (*) appears next to the selected paper size.
Press the Cancel or Online or the @ button repeatedly to exit the MENU mode.

5. Select the correct paper settings in the printer driver before printing the file.

Media type and weight

Set media type and weight as follows:

If media type or media weight are not correctly set, print quality
deteriorates and the fuser roller may be damaged.

Press the Menu [ or {~) button until MEDTA MENU is displayed, then press the @
button.

Press the @ or @ button until MEDIA TYPE or MEDIA WEIGHT for the required tray
is displayed, then press @ button.
Press the E} or @ button until the required paper type or weight is displayed,

then press the @ button. An asterisk (*) appears next to the selected paper type or
weight.

Press the Cancel or Online or the @ button repeatedly to exit the MENU mode.

Select the correct paper settings in the printer driver before printing the file.
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INTERFACES

Your printer is equipped with a selection of data interfaces:

1.

Parallel - For direct connection to a PC. This port requires a bi-directional (IEEE
1284 compliant) parallel cable.

USB - For connection to a PC running Windows 2000 or later or Mac OS X or later.
This port requires a cable conforming to USB version 2.0 or above.

The operation of a printer is not assured if a USB compatible device is connected
concurrently with other USB-compatible machines.

When connecting multiple printers of the same type, they appear as ***** x*x*xx
(2), ¥**** (3), etc. These numbers depend on the order of connecting or turning on
each printer.

LAN - For network cable connection. This port is standard on the B410dn, B430dn
and B440dn.

NOTE
> It is not recommended that you connect serial/USB and parallel cables to
the printer simultaneously.

> Interface cables are not supplied with your printer.

If you are connecting your printer directly to a stand alone computer proceed to the chapter
entitled “Printer Drivers”.

If your printer is to be installed as a network printer, please refer to the relevant section in
the User’s Guide for the network interface card for further details on how to configure the
network connection before installing the printer drivers.

NOTE
Administrator’s authority is required when installing a network connection.
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PRINTER DRIVERS

This chapter describes how to install a printer driver on two types of operating system -
Windows and Macintosh.

The printer drivers are all contained on the printer driver CD-ROM (CD1). Please refer to
the readme file on this CD for the latest information on printer driver installation.

WINDOWS OPERATING SYSTEMS

1. With Windows running, insert the printer driver CD-ROM (CD1) into your CD-ROM
drive.

2. If the CD does not run automatically, use Start > Run... and enter E:\setup (where E
is your CD-ROM drive) in the Open field.

3. Click on OK.
4. Select your printer model.

5. Click on Driver Installation > Install Printer Driver and follow the on-screen prompts
to complete your printer driver installation.

6. For the B410d, B410dn only, once the driver has been installed, the Printer Menu
Setup tool is then automatically installed and the operator panel language switching
utility will run automatically.

NOTE
Take time to note the facilities available on the CD. For example, the Help
facility briefly describes each of the Software Utilities.

7. For the B430d, B430dn,B440dn, once the driver has been installed, the operator
panel language switching utility will run automatically. Choose your preferred
operating language. See “Changing language” on page 14.

INSTALLED OPTIONS

Certain options may have been installed in your printer. For those that are installed, check
that they appear enabled on the Menu Map.

Ensure that your options are set up in the printer driver(s) by making the appropriate
settings on the Device Options tab (PCL emulation) and/or Device Settings tab (PS
emulation) described in the chapter entitled “"Operation”.

MACINTOSH OPERATING SYSTEMS
Please refer to the readme file on CD1 for details on installing the appropriate Macintosh
drivers.

INSTALLED OPTIONS

Ensure that any installed options are enabled in the printer driver.

CHOOSING A MAC DRIVER
The B410d, B410dn models allow you to use only a PCL Mac driver.

The B430d, B430dn and B440dn models can also use a PS driver on Macintosh operating
systems.
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OPERATION

This chapter provides a broad outline of how to operate your printer from either a Windows
or a Macintosh environment. In the former, while PCL emulation is available on all printer
models, PS emulation is optional on the B430d, B430dn and B440dn models.

PRINTER SETTINGS IN WINDOWS

NOTE

The illustrations in this guide relate to Windows XP PCL and PS emulations -
other operating system windows may appear slightly different but the
principles are the same.

The operator panel controlled menus and Printer Menu Setup Tool (described in the chapter
entitled “Operator panels”) provide access to many options.

The Windows printer driver also contains settings for many of these items. Where items in
the printer driver are the same as those in the operator panel and Printer Menu Setup Tool
menus, and you print documents from Windows, the settings in the Windows printer driver
will override those settings in the operator panel and Printer Menu Setup Tool menus.

PRINTING PREFERENCES IN WINDOWS APPLICATIONS

When you choose to print your document from a Windows application program a Print
dialogue box appears. This dialogue usually specifies the nhame of the printer on which you
will print your document. Next to the printer name is a Properties button.

When you click Properties a new window opens which contains a short list of the printer
settings available in the driver, which you can choose for this document. The settings
available from within your application are only those which you may want to change for
specific applications or documents. Settings you change here will usually only last for as
long as the particular application program is running.

PCL EMULATION
The tabs available are the Setup Tab, the Job Options Tab and the Image Tab.
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Setup tab

‘,-;3 My Printer Printing Preferences

Setup | Job Options | Image

Mledia
1 ———Size Letter 25+ 11in i~ -
|

2 0 .Souce |Automatcaly select w

Weight; | Printar Setting || 1

Faper Feed Options

Finizhing Mode
3 ——— | Standaid / M-up hd [ —

2-5ided Frinting @%ﬁ@f
4 —— | [Hone) b [E] e

X i &
Diuplex Help

Diriver Settings
5 —L < Defaul v

Letter 8.5 x 11in

[ About.. ] [ Debault ]’—— 6

Paper size should be the same as the page size of your document (unless you wish
to scale the printout to fit another size), and should also be the same as the size of
paper you will feed into the printer.

You can choose the source of the paper to feed, which may be Tray 1 (the standard
paper tray), Manual Feed Tray (B410d, B410dn), Tray 2 (if you have the optional
second paper tray installed) or the Multi Purpose Tray (B430d, B430dn, B440dn).
You can also click on the appropriate part of the screen graphic to select your
preferred tray.

A variety of document finishing options can be selected, such as normal one page
per sheet, or N-up (where N can be 2 or 4) for printing scaled down pages at more
than one page per sheet.

Under 2-sided Printing, you can choose from auto or manual. Under manual 2-sided
Printing you can choose to print on one side of a sheet only or to use 2-sided
printing (duplex printing). Your printer allows you to carry out manual duplex
printing, meaning you must pass the paper through the printer twice. For more
information, see “2-sided printing” on page 49. The Duplex Help button also offers
guidelines on how to carry out manual duplex printing.

If you have changed some printing preferences before and saved them as a set, you
can recall them to avoid having to set them individually each time you need them.

A single on-screen button restores the default settings.
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Job options tab

“z My Printer Printing Preferences
Setup | Job Options | Image
Qluality Print Mode
() Wector - 4
() Raster
Copies
1 B (16 45
1 O High Quality[1 200x1200) Scale
() Nomal(500x600) 100 C [ 25-400% ) -1 6
() Draft[300x300] [ Tarer Saving [ Digabled
Orientation
2 LI | (&) Portrait [1en
() Landscape  []180
s
Defauk  ++1— 7

1. The output resolution of the printed page can be set as follows.

> The ProQ1200 setting for B410d and B410dn prints at 2400 x 600dpi. This setting
requires the most printer memory and takes the longest to print. Your printed pages
can be scaled to fit larger or smaller stationery. It is the best option for printing
photographs.

> The High Quality setting prints at 1200 x 600dpi for B410d, B410dn and 1200 x
1200dpi for B430d, B430dn and B440dn is the best option for printing vector
objects such as graphics and text.

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs.

> The Draft setting prints at 300 x 300dpi and is suitable for printing draft
documents that contain mainly text. You can select Toner Saving to save toner
for some print jobs.

2. Page orientation can be set to either portrait (tall) or landscape (wide). Both views
can be rotated by 180 degrees.

3. You can print watermark text behind the main page image. This is useful for marking
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do
not want to use pre-printed stationery, you can create your own using Overlays (for
B430d, B430dn and B440dn). For more information on Overlays and Macros refer to
“Overlays and Macros (Windows only)” on page 53. The Overlays button also offers
guidelines on how to carry out manual duplex printing.

4. In Raster (bitmap) mode, processing of the page image is done in the computer
leaving little processing for the printer to do, although the file size may be large. In
Vector mode, file sizes may be smaller and so transmission over a network, for
example, may be faster. These effects are more pronounced for graphics printing
than for text printing.

5. You can select up to 999 copies to print consecutively, although you will need to top
up the paper tray during such a long print run.

6. Your printed pages can be scaled to fit larger or smaller stationery, within a range of
25% to 400% of the original size.
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7. A single on-screen button restores the default settings.
Image tab
2 My Printer Printing Preferences
Setup | Job Dptmnsl Image |
1 Dithering Pattern
@ ieshi
O Line &t
22—~ Dithering Texture
(®) Fine:
© Mormal
O Coarse
3 [] Disable gray scale printing
i anual &djustment
. Lightress: |01 O (&) [im] = ':(:):'
Conprast: |0 @ (&) [im] (2] >
[ Celat ] 5
1. Dithering produces an intermediate greyscale by adjusting the combination of dots
used in printing. Selecting a setting determines the degree of detail with which a
graphics image will be printed. Mesh determines that a screen of dots is used for
dithering while Line Art determines that an array of lines is used for dithering.
2. Select dithering texture by setting the size of dots used in the halftone screen.
3. Set this control to print greyscale effects in black without dithering. Select the
check-box to disable greyscale printing or de-select the check-box to enable
greyscale printing.
4. You can manually adjust lightness (the higher the setting the lighter the print) and
contrast (the higher the setting the greater the contrast).
5. A single on-screen button restores the default settings.
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PS EMULATION
The tabs available are the Layout Tab, the Paper/Quality Tab and the Job Options Tab.

é My Printer Printing Preferences

Layeut | Paper/Guality | Job Options

Orientation

1 — & Pomrait

(O Landscape

() Rotated Landscape

Fiint on Both Sides

2 1 _ (@ Nome

() Flip on Long Edge
() Flip on Short Edge

Page Order
3 1l (@ Frontto Back
(2 Back to Front
4 ——Pages Per Sheet:

Advanced —7— 5

Page orientation can be set to portrait (tall), landscape (wide) or landscape rotated

Print on both sides (duplex printing) can be set to long edge or short edge of the

Printed page order can be set as front to back or back to front of the document.

Set the number of pages to be printed on a single sheet. You can also set it to print

Click the Advanced button to be able to set further document options as follows:

Layout tab
1.
by 180 degrees.
2.
document.
3.
4.
a booklet.
5.
1.

My Printer Advanced Options

ﬁs Advanced Document Settings
il = IE PaperjOutput

= @ Grab
TrueType Fant: Substitute with Device Fant
= = ﬁh Document Cplions
Advanced Printing Features: Enabled
+ %‘éa PostScript Options
= % Printer Features
Paper Size Check: ©n
Media Type: Printer Setting
Tray Switch: On

Letker

Page Rotate: Mormal

Multipurpose kray is handled as manual feed: Mo

Select the required printed paper size.

You can substitute another font for TrueType Font.

You can set other document options as required, including PostScript options and

printer features.

Operation > 43



Paper/Quality tab

' My Printer Printing Preferences 28

Layout | Paper/Quality | Job Options

Tray Selection

Paper Source; @ Automatically Select e

Ok l [ Cancel

You can set the paper source or leave it as automatic selection and by using the Advanced
button you have access to the same set of options as described above for the Layout Tab.
Job options tab

2 My Printer Printing Preferences

Layout | Paper/Quality | Job Options

[1-933) —_ 3

a0z  ——L 4

" High Quality[1200x1200)

+ MNormal(500+600)

[ Toner Save

> Watermark... Overlay. ‘ Advanced... | ST 5

fbou.. | Defail | ——— 6

1. The output resolution of the printed page can be set as follows.

> The ProQ1200 for B410d and B410dn setting prints at 2400 x 600dpi. This setting
requires the most printer memory and takes the longest to print. It is the best
option for printing photographs.

> The High Quality setting prints at 1200 x 600dpi for B410d, B410dn and 1200 x
1200dpi for B430d, B430dn and B440dn is the best option for printing vector
objects such as graphics and text.

> The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs.
You can select Toner Saving to save toner for some print jobs.
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6.

You can print watermark text behind the main page image. This is useful for marking
documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do
not want to use pre-printed stationery, you can create your own using Overlays (for
B430d, B430dn and B440dn). For more information on Overlays and Macros, refer to
“Overlays and Macros (Windows only)” on page 53. The Overlays button also offers
guidelines on how to carry out manual duplex printing.

You can select up to 999 copies to print consecutively, although you will need to top
up the paper tray during such a long print run.

Your printed pages can be scaled to fit larger or smaller stationery.

Using the Advanced button gives you access to the facility to set mirror image
printing and negative image printing.

A single on-screen button restores the default settings.

SETTING FROM WINDOWS CONTROL PANEL

When you open the driver properties window directly from Windows, rather than from
within an application program, a somewhat more extensive range of settings is provided.
Changes made here will generally affect all documents you print from Windows
applications, and will be remembered from one Windows session to the next.

PCL emulation

The main tabs are the General Tab, Advanced Tab and Device Options Tab.

General tab
=1 My Printer Properties
General | Sharing | Ports | Advanced | Color Management | Device Dptions
el
@ by Printer
Locatior:
Comment:
Muodel: My Printer
1 Features
Calor: No Paper available:
Double-sided: Yes Letter
Staple: Mo
Speed: 28 ppm
Maximum resolution: Unknown
2 Frinting Preferences ][ PFrint Test Page —_t 3
1. This area lists some of the main features of your printer, including optional items.

This button opens the same windows as described earlier for items which can be set
from within application programs. Changes you make here, however, will become
the new default settings for all Windows applications.

This button prints a test page to ensure that your printer is working.

NOTE
The above features are provided by the Windows XP operating system and will
vary with other operating systems.
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Advanced tab

<z My Printer Properties
General | Sharing | Ports | Advanced | Color Management | Device Options
1 — 1 (® Always available
() Awailable from
2 ——— Priarity: |1 :
Diiver. |y Printer v
3 — L1 (& Spool print documents so program finishes printing faster
() Start printing after last page is spooled
(&) Stail printing immediately
4 L) Print directly to the printer
5 — - [THald mismatched documents
6 ————— [¥] Frint spooled documents first
77— [ Keep printed documents
8 ——— [¥] Enable advanced printing features
9 — 1| PiningDefauts.. | [ Frirt Frocessor. | [ Geparator Page 10

1. You can specify which times of day your printer will be available.

Indicates current priority, from 1 (lowest) to 99 (highest). Highest priority
documents will print first.

3. Specifies that documents should be spooled (stored in a special print file) before
being printed. The document is then printed in the background, allowing your
application program to become available more quickly. Options follow:

This specifies that printing should not start until the last page has been spooled. If
your application program needs a lot of time for further computation in the middle of
printing, causing the print job to pause for more than a short period, the printer could
prematurely assume that the document has finished. Selecting this option would
prevent that situation, but printing will be completed a little later, as the start is
delayed.

This is the opposite choice to the one above. Printing starts as soon as possible after
the document begins spooling.

4. This specifies that the document should not be spooled, but printed directly. Your
application will not normally be ready for further use until the print job is complete.
This requires less disk space on your computer, since there is no spool file.

5. Directs the spooler to check the document setup and match it to the printer setup
before sending the document to print. If a mismatch is detected, the document is
held in the print queue and does not print until the printer setup is changed and the
document restarted from the print queue. Mismatched documents in the queue will
not prevent correctly matched documents from printing.

6. Specifies that the spooler should favour documents which have completed spooling
when deciding which document to print next, even if completed documents are lower
priority than documents which are still spooling. If no documents have completed
spooling, the spooler will favour larger spooling documents over shorter ones. Use
this option if you want to maximise printer efficiency. When this option is disabled
the spooler chooses documents based only on their priority settings.

7. Specifies that the spooler should not delete documents after they are completed.
This allows documents to be re submitted to the printer from the spooler instead of
printing again from the application program. If you use this option frequently it will
require large amounts of disk space on your computer.

8. Specifies whether advanced features, such as pages per sheet, are available,
depending on your printer. For normal printing keep this option enabled. If
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compatibility problems occur you can disable the feature. However, these advanced
options may then not be available, even though the hardware might support them.

9. This button provides access to the same setup windows as when printing from
applications. Changes made via the Windows Control Panel become the Windows
default settings.

10. You can design and specify a separator page that prints between documents. This is
particularly useful on a shared printer to help each user find their own documents in
the output stack.

NOTE
The above features are provided by the Windows XP operating system and will
vary with other operating systems.

Device options tab

"4 My Printer Properties @1

General | Sharing | Ports | Advanced | Color Management | Device Options
Ayailable Options
[ Lower Cassette -

1

In this window you can select which optional upgrades are installed on your printer. See
the chapter entitled “Installing options”.

PS emulation

The main tabs are the General Tab, Advanced Tab and Device Settings Tab. The
General and Advanced tabs are the same as for PCL emulation described earlier.
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Device settings tab

5 My Printer Properties
General | Sharing | Ports | Advanced | Device Settings
1 & My Printer Device Settings
3 @ Faorm To Tray Assignment
o .
2 -

I2TET (e
Output Protocal: TECP

Send CTRL-D Before Each Job: ko

Send CTRL-D After Each Job: Yes

Canwert Gray Text ko PosESCrpt Gray: No
Convert Gray Graphics to PostScript Gray: No

Add Euro Currency Symbol ko PoskScript Fonts: No
Job Timeout: 0 seconds

Wait Timeout: 300 seconds

Mirirnurn Fonk Size to Download a5 Outline: 100 pixel(s
Maxirum Fant Size ko Download as Bitmap: 600 pixel(s)
3 = EI Installable Options

Second tray: Mot Installed

Memory Configuration: 64 ME RAM

1. You can set the desired paper sizes in each of the available paper feed trays.

2. You can make a variety of font settings depending on your application.

3. You can set which optional upgrades are installed on your printer. See the chapter
entitled “Installing options”.

PRINTER SETTINGS IN MACINTOSH

Refer to the readme file on the drivers CD, CD1, and the online help provided in the driver
software.
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2-SIDED PRINTING

The duplex unit adds the function of two-sided printing, using less paper and making large
documents easier to handle. It also enables booklet printing, which uses even less paper.

The duplex unit slides straight into the rear of the printer and requires no tools to install.

A
/8

& “‘
A

>

b,

This printer has the option of Auto Duplex and Manual Duplex printing.

NOTE
The steps in the process relate to Windows XP PCL. Other operating system
windows may appear slightly different, but the principles are the same.

AUTO DUPLEX PRINTING

This option provides automatic two-sided printing only for Letter, A4, Legal 13 and 14 and
Custom paper sizes, using paper stocks from 60 - 105g/m?2.

To carry out Auto Duplex Printing:
1. Select File -> Print and click the Properties button.

2. Select the input tray (Trayl, Tray2 (optional), Multi Purpose Tray (B430d, B430dn
and B440dn) or Manual Feed Tray (B410d, B410dn)) from the Source drop down.

3. In the Duplex printing drop down menu, select either Long Edge (Auto) or Short
Edge (Auto) according to your printing preferences.

4. If you require further information, click the Duplex Help button.
5. Click the Print button.
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MANUAL DUPLEX PRINTING USING THE PAPER TRAY (WINDOWS ONLY)

NOTE
Manual Duplex printing is available only for Windows PCL Driver.

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the printer
twice. You can carry out 2-sided printing using the Paper Tray or the Manual Feed Tray
(B410d, B410dn) or the Multi Purpose Tray (B430d, B430dn and B440dn). You can use A4,
A5, A6, B5, Letter, Legal 13 and 14, Statement, Executive and Custom paper sizes, using
paper stocks from 60 - 124g/m?2.

NOTE
You cannot use A6 paper size for printing from Tray 1 or Tray 2 (option).

Ensure that there is enough paper in the Paper Tray to carry out the print job.
Select File -> Print and click the Properties button.

Select the Multi Purpose Tray from the Source drop down.

WM

In the 2-sided printing drop down menu, select either Long Edge (Manual) or
Short Edge (Manual) according to your printing preferences. If you require further
information, click the Duplex Help button. Then, Click the Print button.

2 My Printer Printing Preferences R[=]

Setup | Joh Options | Image
Media

Size: Letter 5% 11in v ,~

Source; | Automatically selsct ~

“wheight: | Printer Setting v ]

Paper Feed O ptions
Finishing Mode
Standard / M-up |+ || Options. mmmme e

2-Sided Printing

[Maone] »

Driver Settings I I iy

Default v

Add. Letter 8.5 4 11in

[ About... ] l Default ]
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5. Every second page (1) of your document is printed first. When this is complete, a
message appears on screen prompting you to take the paper, flip it and replace it in
the Paper Tray.

6. Open the Paper Tray (2).

7. Take the printed paper from the Output Stacker (3) and place it in the Paper Tray,
ensuring that the printed side is facing up and the bottom of the page facing into the
printer (4).

8. Close the Paper Tray and press the Online button. The message window should
disappear from your screen and the document finishes printing the remaining pages
of your document.

NOTE

You must press the Online button to start the printing for other side. The
default time is set to one minute, failing which, the data is deleted and not
printed.
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MANUAL DUPLEX PRINTING USING THE MANUAL FEED TRAY (B410D, B410DN)

NOTE
> When using the Manual Feed Tray, feed pages one sheet at a time.

> Use the Multi Purpose Tray for Manual Duplex Printing for B430d, B430dn
and B440dn, but the principles are the same, See “"Multi purpose tray and
manual feed tray” on page 33.

1. Position the paper guides on the Manual Feed Tray according to the paper size.

N

Place paper one sheet at a time in the Manual Feed Tray. The paper is automatically
gripped in position.

Select File -> Print to display the Print dialog box.
Click the Properties button.
Select the Manual Feed Tray from the Source drop down.

a0 hw

On the 2-sided printing drop down menu, select either Long Edge (Manual) or
Short Edge (Manual) according to your printing preferences. If you require further
information, click the Duplex Help button.

7. When every second page has printed, take the paper from the output stacker.

8. Set the paper one page at a time in the Manual Feed Tray with the printed side
facing down and the top of the page facing into the printer. Ensure that the paper is
gripped in place.

9. Press the Online button. The remaining pages of your document print on the blank
side of the paper, one sheet at a time as you feed it into the Manual Feed Tray.
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OVERLAYS AND MACROS (WINDOWS ONLY)

WHAT ARE OVERLAYS AND MACROS?

If you would like to print on special stationery, such as forms and letterhead, but do not
want to use pre-printed stationery, you can create your own using these advanced
features.

You can use PostScript overlays to generate all your special stationery and store it in the
printer for use whenever you need it. If you have chosen to install the PCL driver, macros
perform a similar function.

You can create several overlays or macros, and combine them in any way you like to
produce a variety of forms and other special stationery. Each image can be printed on just
the first page of a document, on all pages, on alternate pages, or just the pages that you
specify.

CREATING POSTSCRIPT OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer
(.PRN) file.

2. Use the Storage Device Manager utility software supplied on CD with your printer to
create a “project file,” import the.PRN file(s), and download the generated filter
(.HST) file to the printer. The project file will contain one or more overlay images
which are functionally related, such as the cover page and the continuation page
images for business letters.

3. Use downloaded files to define your overlays ready for use when printing your
documents.

When printing overlay files to disk, do not select any special features, such as two-sided
printing or multiple copies. These are not appropriate to overlays, they apply only to your
final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required
overlay image and save it.

2. Open your application’s Print... dialogue.

3. Make sure that the selected printer name (1) is
that of your PostScript printer driver.

4. Select the Print To File (2) option.

5. Click the Properties button (3) to open the
Document Properties window.

6. On the Overlay tab, choose Create Form from the
drop-down list (4).

Active Dverlay: (e 4)

7. Click OK to close the Document Properties window.
8. Click OK again to close the Print dialogue.

Defined Dverlay: (Mex32)

9. When prompted for a print file name, enter a
meaningful name with the extension.PRN.

10. Close your application.
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CREATE AND DOWNLOAD THE PROJECT

1.

mohwN

10.

11.

From the Windows Start menu, start Storage Device Manager (SDM) and allow
SDM to discover the printer.

Choose Projects—>New Project.
Choose Projects—Add File to Project.
Set the Files of Type drop-down list to PRN Files(*.prn).

Navigate to the folder where the.PRN files are stored and select one or more of these
to include in your overlay set.

You can have more than one printer (.PRN) file in a project. For example, one for top
pages and another for continuation pages. Use standard Windows techniques (Shift
or Ctrl keys) to select multiple files simultaneously if you need to.

Click Open to add these files to the current project.

When a message box appears confirming that a filter file has been created, click OK
to clear the message.

The project window will display one.HST file for each printer file added. Make a
careful note of each of these names. Ensure that you note them exactly as they
appear, they are case sensitive, and you will need them later.

Choose Projects—Save Project and enter a meaningful name (e.g. “Letter
Stationery”) so that you can recognise it later if you want to modify it.

Choose Projects—Send Project Files to Printer to download the project to the
printer.

If you have a hard disk in the printer, SDM will automatically download files to it. If
not, SDM will download files to flash memory. If you have a hard disk but still prefer
to download to flash memory, double-click the file name in the Project window and
under Volume, type in %Flash0% and then click OK.

When the message "Command Issued” appears confirming that the download is
complete, click OK to clear the message.

TEST PRINTING THE OVERLAY

1.
2.

3.
4.

Click on the printer icon for the relevant printer and choose Printers—Test Form.

In the Test PostScript Form window, to test each overlay select it and click OK. There
will be a short pause while the printer processes the form, and then it will print.

When each overlay has been tested, click Exit.

Click the standard Windows Close (X) button, or choose Projects—EXit to close
Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1.

Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start
menu or the Windows Control Panel.

Right-click on the Relevant PostScript printer icon and choose Printing
Preferences from the pop-up menu.

On the Overlay tab, click the New button.
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4. In the Define Overlays window, enter a suitable name (2) i oo 2%
for this overlay and choose which page(s) (3) of your y S B
documents will use this overlay.

5. Enter the name of the overlay file (4) exactly as it appeared
in the Storage Device Manager project window. Remember 4——
that this name is case sensitive. 5—

If you forgot to note the overlay names when you created
them, you can find them using Storage Device Manager to
view the project file, or the printer’s Information Menu to

print a file list and identify them from there.

6. Click Add (5) to add this overlay into the defined overlays list.

7. Click OK to close the Define Overlay window.

The new overlay now appears in the Defined Overlays list in the printer properties
window.

8. Repeat the above procedure if you wish to define more overlays.
9. When done, click OK to close the printer properties window.

Your new overlays are now ready and available to be used for any future documents you
wish.

PRINTING WITH POSTSCRIPT OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you
wish. The example illustrated here uses two overlays for business letters. The first prints
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software.
Remember, if necessary, to format the document so that it will fit within the
appropriate space.

2. Open your application’s Print... dialogue and choose any options you will require,
ensuring that the target printer is your PostScript printer driver in which the overlays
have been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Overlays tab, choose Use Overlay from the [Y—
drop-down list (1).

Active Overlay: (Max 4

5. Click on the first overlay (2) you wish to use. In this
example it is the Cover Page overlay. Then click the
Add button (3).

6. If you want to use another overlay, in this case it is the
Continuation page, click the second overlay (4) and
then click the Add button (3) again.

7. When you have selected all the overlays you want to
use for this document, click OK.

8. Finally, in your application’s print dialogue, click OK to begin printing.
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CREATING PCL OVERLAYS

Three steps are required to create an overlay:

1.

Create the form data using your own application software and print it to a printer
(.PRN) file.

Use the Storage Device Manager utility software supplied on CD with your printer to
create a “project file,” import the .PRN file, and download the generated filter (.BIN)
files to the printer.

Use downloaded files to define your overlay ready for use with any future document.

When printing files to disk, do not select any special features, such as two-sided
printing or multiple copies. These are not appropriate to macros, they apply only to
your final documents.

CREATING THE OVERLAY IMAGE

1.

6.

Use your preferred application, perhaps a graphics program, to create the required
image and save it.

Open your application’s Print... dialogue.

Make sure that the selected printer name (1) is that of 72 &
your PCL printer driver. i

Select the Print To File (2) option.

When prompted for a print file name, enter a
meaningful name with the extension .PRN .

Close your application.

CREATE AND DOWNLOAD MACROS

1.

From the Windows Start menu, start Storage Device Manager (SDM) and allow
SDM to discover the printer.

Choose Projects—>New Project to start a new project.

Choose Projects—Filter Macro File. The Filter Printer Patterns dialogue box
appears. Make any adjustments in the settings that you need and then click OK.

Example: If you create a black oval in MS Paint and leave all the colour command
filters checked, the black oval will print as a black rectangle when the overlay is used.
To maintain the oval shape, turn off (deselect) the “Configure Image Data,” “Palette
ID” and “Palette Control” filters.

Set the Files of Type drop-down list to PRN Files(*.prn).

Navigate to the folder where the overlay .PRN files are stored and select one or more
of these to include in your overlay set.

You can have more than one macro file in a project. For example, one for top pages
and another for continuation pages. Use standard Windows techniques (Shift or Ctrl
keys) to select multiple files simultaneously if you need to.

Click Open to add these files to the current project. (You can also drag and drop files
from Windows Explorer directly into the project window if you prefer.) When a
message box appears confirming that a filter file has been created, click OK to clear
the message.

The project window will display one .BIN file for each printer file added. Make a
careful note of the name and ID number for each of the files. You will need them
later.
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If you wish to edit the names or ID numbers, double-click the file entry and edit the
details.

Note that the names are case sensitive.

8. Choose Projects—Save Project and enter a meaningful name (e.g. “Letter
Stationery”) so that you can recognise it.

9. Choose Projects—Send Project Files to Printer to download the project to the
printer.

10. When the message "Command Issued” appears confirming that the download is
complete, click OK to clear the message.

TEST PRINTING THE MACRO
1. Choose Printers—Test Macro.

2. In the Test Macro window, enter its ID number and click OK. After a short pause the
printer will print the macro.

3. When each macro has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects—EXxit to close
Storage Device Manager.

DEFINING OVERLAYS
This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start
menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing
Preferences from the pop-up menu.

3. On the Job Options tab, click the Overlay button.

4. In the Overlay window, Click the Define Overlays o —
button (1). ™ Print Using Active Ovetlays
I [
Zhne: Dverlays: ‘ .
1 . s | |
o] cowd | Hep | ook |

5. In the Define Overlays window, enter the name (a) and
ID (b) of the required overlay, and define which
page(s) (c) of your documents will use this overlay. Then
click the Add button (3) to add this overlay to the list of

3
defined overlays. Repeat for any other related overlays. :
When done, click the Close button (4) to close the b
window.

c/
The example illustrated shows two overlays defined, one for R e T 12
a cover page and one for continuation pages. 4— | ——

Remember that names and IDs of overlay files must be entered exactly as they
appeared in the Storage Device Manager project window. Remember also that names
are case sensitive.

If you forgot to note the overlay name or ID when you created them, you can find
them using Storage Device Manager to view the project file, or the printer’s
Information Menu to print a file list and identify them from there.
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The new overlays will now appear in the Defined Overlays list in the printer properties
window.

6. When done, click OK to close the printing preferences window.

Your new overlays are now ready and available to be used for any future documents you
wish.

PRINTING WITH PCL OVERLAYS

Once you have defined your overlays you are ready to use them for any documents you
wish. The example illustrated here uses two overlays for business letters. The first prints
on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software.
Remember, if necessary, to format the document so that it will fit nicely within the
plain areas on your letterhead overlay.

2. Open your application’s Print... dialogue and choose any options you will require,
ensuring that the target printer is your PCL printer driver in which the overlays have
been defined.

3. Click the Properties button to open the Printing Preferences window.

4. On the Overlay tab, check the Use active overlays T
checkbox (1). 1 IeT—

5. In the Defined Overlays list, click on the first overlay (2)
you wish to use, and click the Add button (3) toadditto 3_ |
the Active Overlays list. (If you want a reminder of how
this overlay looks, click the Test Print button.)

\.
4

rrrrrrrrr

6. If you want to use another overlay with this document, in
this example it is the “Continuation Page” overlay, click e

this overlay (4) in the list of defined overlays, and then
click the Add button (3) again to add the second overlay to the list of active
overlays.

7. When the list of active overlays contains all the items you want to use, click OK.

8. Finally, click the Print button in your application’s Print dialogue to begin printing
your document.
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CONSUMABLES AND MAINTENANCE

This section deals with the replacement of the toner cartridge and image drum and general
maintenance.

CONSUMABLE ORDER DETAILS

ITEM LIFE ORDER NO.
Toner, standard, B410d, B410dn, B430d, 3500 A4 @ 43979102 (EU only)
B430dn, B440dn ISO/IEC19752 43979107 (non-EU)
Toner, high capacity, B430d, B430dn, B440dn 7,000 A4 @ 43979202 (EU only)

ISO/IEC19752 43979211 (non-EU)
B440dn 10000 A4 @ 43979207 (EU only)

ISO/IEC19752 43979212 (non-EU)
Image drum 25,000 A4 pages 43979002

Please always use genuine consumables.

TONER CARTRIDGE LIFE

How long your toner cartridge lasts depends on the print density; the percentage of the
page that prints black. A typical letter has 3% to 5% print density; graphics usually have
higher density. Higher print density means toner is used up faster. At 5% print density, a
standard toner cartridge will print an average of 3500 pages. Remember, this is only an
average:actual results may vary.

The first toner cartridge installed in a new printer has to fill the image drum reservoir and
saturate the developing roller with toner. The toner cartridge that is supplied with this
printer normally produces about 1,500 pages after installation.

WHEN TO REPLACE THE TONER CARTRIDGE

When the toner is running low, TONER LOW is displayed in the operator panel LCD. After
Toner Low displays, the printer will print about 100 more pages then display Toner Empty
and stop printing. Printing will resume after a new toner cartridge has been installed.

REPLACING THE TONER CARTRIDGE

> Never expose a toner cartridge to an open flame. It can cause
an explosion and you can be burned.

> Be sure to switch off and unplug the machine before accessing
the interior of a machine for cleaning, maintenance or fault
clearance. Access to a live machine’s interior can cause electric
shock.

It is recommended that you clean the LED array at the same time as you change the toner
cartridge.

The toner used in this printer is a very fine dry powder contained in the toner cartridge.

Have a sheet of paper handy so that you have somewhere to place the used cartridge while
you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the new one came in. Follow
any regulations, recommendations, etc., which may be in force concerning waste recycling.
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If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, damp
cloth to remove any residue. Do not use hot water, and never use solvents of any kind.
They will make stains permanent.

If you inhale any toner or get it in your eyes, drink a little water or
bathe your eyes liberally in cold water. Seek medical attention
immediately.

1. Switch off the printer and allow the fuser to cool for about 10 minutes before
opening the top cover.

If the printer has been powered on, the fuser may be hot. This area
is clearly labelled. Do not touch.

2. Press the top cover release button and open the printer’s top cover fully.

NOTE
The B430dn model has been illustrated below. The principles are the same for
all models of this printer.

3. Pull the coloured lever (1) on the right side of the toner cartridge towards the front
of the printer to close the cartridge then remove the used toner cartridge (2).

4. Clean the top of the ID unit with a clean, lint free cloth.

5. Put the cartridge down gently onto a piece of paper to prevent toner from marking
your furniture.

6. Remove the new cartridge from its box but leave its wrapping material in place for
the moment.
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7. Gently shake the cartridge (3) from end to end several times to loosen and distribute
the toner evenly inside the cartridge.

8. Remove the wrapping material and peel off the adhesive tape from the underside of
the cartridge (4).
9. Holding the cartridge by its top centre with the coloured lever to the right (5), lower

it into the printer over the image drum unit from which the old cartridge was
removed.

10. Insert the left end of the cartridge into the top of the image drum unit first (6), push
it against the pins on the drum unit, then lower the right end of the cartridge down
onto the image drum unit (7).
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11. Pressing gently down on the cartridge to ensure that it is firmly seated, push the
coloured lever towards the rear of the printer (8). This will lock the cartridge into
place and release toner into the image drum unit.

13. Close the top cover and press it down to latch it closed.
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IMAGE DRUM LIFE

The life of an image drum depends on a number of factors, including temperature and
humidity, the type of paper used, and the number of pages per job.

The image drum should last approximately 25,000 pages continuous printing. This number
is approximate because different numbers of pages are printed each time and the
environmental conditions and the paper type used may vary.

WHEN TO REPLACE THE IMAGE DRUM

When the drum reaches 90% of its life, a CHANGE DRUM message is displayed in the operator
panel LCD. Change the image drum when the print becomes faint or begins to deteriorate.

REPLACING THE IMAGE DRUM.

> Never expose a image drum to an open flame. It can cause an
explosion and you can be burned.

> Be sure to switch off and unplug the machine before accessing
the interior of a machine for cleaning, maintenance or fault
clearance. Access to a live machine’s interior can cause electric
shock.

NOTE
> It is recommended that you change the toner cartridge and clean the LED
array at the same time as you change the image drum.

> The B430dn model has been illustrated below. The principles are the same
for all the models of this printer.

1. Press the cover release and open the printer’s top cover fully.

If the printer has been powered on, the fuser may be hot. This area
is clearly labelled. Do not touch.

2. Holding it by its top centre, remove the used image drum and toner cartridge, out of
the printer.
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3. Put the assembly down gently onto a piece of paper to prevent toner from marking
your furniture and to avoid damaging the green drum surface.

The green image drum surface at the base of the ID unit is very
delicate and light sensitive. Do not touch it and do not expose it to
normal room light for more than 5 minutes. If the drum unit needs
to be out of the printer for longer than this, please wrap the
cartridge inside a black plastic bag to keep it away from light.
Never expose the drum to direct sunlight or very bright room
lighting.

4. With the coloured toner release lever to the right, pull the lever towards you. This
will release the bond between the toner cartridge and the image drum unit.

5. Lift the right-hand end of the toner cartridge and then draw the cartridge to the right
to release the left-hand end, and withdraw the toner cartridge out of the image
drum cartridge. Place the cartridge on a piece of paper to avoid marking your
furniture.

6. Take the new image drum cartridge out of its packaging and place it on the piece of
paper where the old cartridge was placed. Keep it the same way round as the old
unit. Pack the old cartridge inside the packaging material for disposal.

NOTE
Follow instructions that come with the new image drum for additional
information such as the removal of packaging material etc.

7. Place the toner cartridge onto the new image drum cartridge. Push the left end in
first, and then lower the right end in.

8. Push the coloured release lever away from you to lock the toner cartridge onto the
new image drum unit and release toner into it.

9. Holding the complete assembly by its top centre, lower it into place in the printer
locating the pegs (1 & 2) at each end into their slots in the sides of the printer cavity

(3).

10. Gently wipe the LED array surface with a soft tissue.

11. Close the top cover and press it down to latch it closed.
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GENERATING A CLEANING PAGE

If the printed page shows signs of fading, streaking or erratic marks, the problem may be
cleared by generating a drum cleaning page as follows.

B410p, B410DN

Using the Printer Menu Setup Tool

1.

2
3.
4

U

6.

Start the Printer Menu Setup Tool for the printer.
Click Maintenance Menu.
Select Cleaning and click Execute.

Open the Manual Feed Tray and insert a sheet of A4 plain paper between the paper
guides, then click OK.

The printer grips the paper and prints a cleaning page.

If subsequent printing appears faded or uneven, try replacing the toner cartridge.

Using the Online button

1.
2.

L O O

Press the Online button to take the printer OFF LINE.

Open the Manual Feed Tray and insert a sheet of A4 plain paper between the paper
guides, for loading paper See “Multi purpose tray and manual feed tray” on page 33.

Press and hold down the Online button for at least seven seconds.
The printer grips the paper and prints a cleaning page.
Return the printer ONLINE by pressing the Online button.

If subsequent printing appears faded or uneven, try replacing the toner cartridge.

B430p, B430DN, B440DN

1.

Open the Multi Purpose Tray and insert a sheet of A4 plain paper between the paper
guides, for loading paper See “Multi purpose tray and manual feed tray” on page 33.
To print from the Paper Tray, press the Online button when the LCD display prompts
you to insert a sheet of paper in the Paper Tray.

Press the Menu E or @ button repeatedly until MAINTENANCE MENU is displayed,

then press the @ button.

Press the [~ or {~) button until CLEANING PRINT is displayed.
Press the @ button.

The printer grips the paper and prints a cleaning page.

Press Cancel or Online or the @ repeatedly to exit the MENU mode. The printer
should now be ON LINE.

If subsequent printing appears faded or uneven, try replacing the toner cartridge.
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CLEANING THE LED ARRAY

Clean the LED array whenever a new toner cartridge is installed or if there are faded vertical
areas or light printing down a page.

Wipe the LED array gently with a soft tissue.
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TROUBLESHOOTING

STATUS AND ERROR MESSAGES

Your printer has been designed to give you helpful status feedback not only during normal
operation but also if a printing problem occurs so that you can take appropriate corrective
action.

The LCD on the printer operator panel provides the self-explanatory status and error
messages in your chosen language. Error messages are accompanied by the Ready
indicator being extinguished.

PAPER JAMS

Provided that you follow the recommendations in this guide on use of print media, and you
keep the media in good condition prior to use, your printer should give years of reliable
service. However, paper jams occasionally do occur, and this section explains how to clear
them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper
path through the printer. When a jam occurs, the printer immediately stops, and the
operator panel informs you of the event. If printing multiple pages (or copies), do not
assume that having cleared an obvious sheet that others will not also be stopped
somewhere along the path. These must also be removed in order to clear the jam fully and
restore normal operation.

The printer may experience a paper jam in one of three areas.

1. INPUT JAM - paper has failed to leave the selected feed tray and enter the internal
paper path of the printer. A typical message indicates a paper jam and identifies the
tray to check.

2. FEED JAM - paper has entered the printer but failed to reach the exit. A typical
message indicates a paper jam and advises you to open the top cover for access.

3. EXIT JAM - paper has reached the exit but has failed to exit completely from the
printer. A typical message indicates an exit jam and advises you to open the top
cover for access.
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INPUT JAM

NOTE
The B430dn model has been illustrated below. The principles are the same for
all models of this printer.

1. Remove the paper tray from the printer (1).
Remove any crumpled or folded paper.

3. Remove any paper from the underside of the printer (2).

4. Replace the paper tray.

After successful removal of any damaged or misfed paper, the printer should continue
printing.

FEED JAM OR EXIT JAM

1. Remove the tray and clear any misfed sheets as given above.

2. Press the cover release and open the printer’s top cover.

If the printer has been powered on, the fuser area will be hot. This
area is clearly marked. Do not touch it.

Never expose the image drum unit to light for more than 5 minutes.
Never expose the image drum unit to direct sunlight. Always hold
the image drum unit by the ends or from the top. Never touch the
surface of the green drum inside the image drum unit.
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3. Carefully lift out the image drum, complete with the toner cartridge. Be careful not
to touch or scratch the green drum surface.

4.

5. Re-install the image drum complete with toner cartridge, ensuring that the pegs (1 &
2) correctly locate into the slots on each side of the printer (3).

6. Lower the top cover but do not press down to latch it closed yet. This will protect the
drum from excessive exposure to room lighting, while you check the remaining area
for jammed sheets.

7. Open the rear cover and check for paper in the rear path.
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> Pull out any paper found in this area.

> If the paper is low down in this area and difficult to remove, it is probably still
gripped by the fuser. In this case, raise the top cover, reach around and press
down on the fuser pressure release lever.

> If you are not using the rear cover, close it once the paper is removed from this
area.

8. Remove the Duplex unit (1) and check for any paper in this area. Remove any paper
and replace the duplex unit.

> If the paper is difficult to remove, push the cover in the arrow direction, raise it
and remove the paper.

9. Open the Multi Purpose Tray (1) (Manual Feed Tray for B410d and B410dn).
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10.
11.

> Remove any paper that you find (2), and then close the tray.

Close the top cover and press down to latch it closed.

The printer will warm up and commence printing when ready. The page lost through

the jam will normally be reprinted.

NOTE

If the edge of the jammed paper protrudes (or can be seen) from the exit,

reinstall the image drum, close the top cover and switch the printer on. Remove
the jammed paper from the exit when the exit roller begins rotating after a few
seconds after switching on. However, if the jammed paper cannot be removed,
contact a service representative.

PRINT QUALITY PROBLEMS

Before consulting a service representative regarding a print quality problem, check the

table below to see if there is a solution, or something you might have overlooked.

SYMPTOM

Blank sheets printed.

PROBLEM

Image drum cartridge
not properly installed.

SOLUTION

Reinstall image drum cartridge.

Empty or missing toner
cartridge.

Install new toner cartridge.

Entire page prints
faintly.

Empty toner cartridge.
Pages get fainter when
toner is used up.

Install new toner cartridge.

LED array is dirty.

Clean LED array.

Page has grey
background.

Static electricity,
generally from dry
environments, causes
toner to stick to
background.

Change paper to a smoother laser bond or
use a humidifier.

Page prints all black.

Hardware problem.

Contact service.

Page has repetitive
marks.

Damaged image drum
cartridge causes
repetitive marks every
1.6 inches (4.06 cm)
due to surface nicks and
scratches.

Generate a cleaning page, repetitive marks
may be temporary.

Oblong area of faint
print appears on
each page.

Drop out caused by
using paper exposed to
high humidity.

Change paper stocks, check paper storage
environment or use a dehumidifier; check
toner level.
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SYMPTOM

Vertical white
streaking or faint
areas on page.

PROBLEM

Toner is low and does
not distribute properly,
or the drum is worn out.

SOLUTION

Replace toner cartridge. Check drum and
replace the drum, if necessary. Contact
service.

LED array is dirty.

Clean LED array.

Vertical black lines.

Hardware problem.

Contact service.

Fuzzy print.

LED array is dirty.

Clean LED array.

Distorted print.

Paper path, lamp
assembly, or fusing unit
problem.

Generate cleaning page.
Contact service.

Faded print.

Toner cartridge is not
correctly installed.

Toner low.

Install toner cartridge correctly.

Replace toner cartridge.

Smeared or blotched
print.

Dirty rollers; toner
dropped inside printer or
image drum problem.

Replace image drum and toner.
Contact service.

Printed page is light/
blurred.

Is toner low?

Replace toner cartridge.

Is paper meant for laser
printers?

Use recommended paper.

LED array is dirty.

Clean LED array.

Bold characters and
dark lines are
smeared.

Toner is low.

Install new toner cartridge.

Print is darker than
usual.

Darkness setting is too
high.

Change darkness setting.

Pages curl
excessively.

Printing on wrong side
of paper.

Turn paper over in tray. (Note arrow on
paper package). Install paper print side
down in tray.

Moisture in paper.
Improper storage.

Avoid storing paper in areas of excessive
temperature and humidity. Store paper in
protective wrapping.

High humidity.

Recommended operating humidity: 20-
80%.

Troubleshooting > 72




PAPER FEED PROBLEMS

SYMPTOM

Paper Jams occur frequently.
Multiple sheets of paper are
fed at the same time.

PROBLEM

The printer is tilted.

SOLUTION

Place the paper on a stable
and flat surface.

Paper is too thick or too thin.
Paper is moist, folded,
creased or warped.

Use paper suitable for the
printer. Avoid storing paper in
areas of excessive
temperature and humidity.
Store paper in protective
wrapping

Paper is not aligned.

Align the paper edges to the
paper guides.

Only one sheet of paper is
loaded in the Paper tray or
Manual Feed/Multi Purpose
tray.

Load several sheets of paper.

Sheets of paper is added to
the existing paper stock in the
Paper tray or Manual Feed/
Multi Purpose tray.

Remove existing sheets of
paper from the tray and add
the new sheets to them,
ensuring alignment and then
load the tray.

Postcards, envelopes, label
sheets or transparencies are
loaded in the Paper tray.

Postcards or envelopes are
placed in the wrong
orientation.

You cannot print using the
Paper tray. Load postcards,
envelopes, label sheets or
transparencies in the Manual
Feed tray or Multi Purpose
tray.

Check and load in the correct
orientation.

Paper is not fed into the
printer.

Improper setting is selected
for Paper Source in the
printer driver.

Select the correct paper
source from the Source drop
down menu.

The printer menu setting is
incorrect.

Set the size of the paper in
the Setup Menu of the printer.

Printing does not resume after
removing jammed paper.

Printing does not resume only
by removing paper jam.

Open and close the top cover.
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SOFTWARE PROBLEMS

Your software (operating environment, applications and printer drivers) controls the
printing process. Make sure you have selected the right driver for use with your printer.

See your software documentation for more information.

SYMPTOM

Printing is garbled.

PROBLEM

Incorrect driver is
installed.

SOLUTION

Install an appropriate driver.

Printer’s output is
below rated speed.

Much of the printing
delays will be caused by
your application.
Sometimes purely text
documents will print
slowly depending on the
selected fonts and how
they are transferred to
the printer.

For maximum speed, use text in your
document and use a printer resident font.

Size of top margin
increases with each
page printed.

Creeping text. Number
of lines per page in
software is not equal to
number of lines per
page of printer.

Many software packages assume 66 lines
per page, but your printer’s default is 64.
Adjust software accordingly, or set LINES
Per PAGE in the soft control panel to equal
lines per page in your software.

HARDWARE PROBLEMS

SYMPTOM

Graphic image prints
partly on one page,
partly on the next.

PROBLEM

Insufficient printer
memory for this image
at this resolution.

SOLUTION

Change the resolution, reduce the image
size, or install more memory in your
printer.

When you try to
print nothing
happens, but printer
indicates it is ready
to receive data.

Configuration error.

Check cable connection. If more than one
printer is available, make sure your printer
has been selected.

Garbage prints.

Incorrect cable
configuration. Also, see
Software Problems.

Check cable configuration, continuity, and
length.

Printer freezes or
displays error
message when

Booting the computer
while the printer is on
can cause a

Turn printer off before rebooting computer.

forms or adhesives
passing through the hot
fusing unit.

computer is communications error.
rebooted.
Odours. Gases are given off by Make sure the forms you use can withstand

heating, and provide adequate ventilation.

Printer is on but
must warm up
before a job is
printed.

Power Save mode is set
on to conserve energy.
The fuser must heat up
before you can begin
printing the next job.

To eliminate warm up delay, change Power
Save setting.
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INSTALLING OPTIONS

The following options are available to extend the performance of your printer:

> 32, 64, 128, 256MB RAM DIMM: to extend the main memory of your printer and
speed up the processing of large files

> Second paper tray: to increase your printer’s paper handling capacity by 530 sheets
(75g/m?2)

INSTALLING OPTIONS ORDER NUMBERS

32MB RAM DIMM 44029502
64MB RAM DIMM 44029504
128MB RAM DIMM 44029506
256MB RAM DIMM 44029509
Second Paper Tray 43990702

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation sheet that accompanies
the option.
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SPECIFICATIONS

GENERAL

PRINTER MODEL MODEL NUMBER

B410d N22110B
B410dn N22113B
B430d N22111B
B430dn N22115B
B440dn N22116B

A summary of the basic characteristics of your printer appears in the table below:

ITEM SPECIFICATION

Dimensions B410d, B410dn: 369mm x 395mm x 268mm (W x D x H)
B430d, B430dn: 369mm x 395mm x 268mm (W x D x H)
B440dn: 369mm x 395mm x 297mm (W x D x H)

Weight B410/B430: 10.3 kg approximately (without second tray)

B440: 10.9 kg approximately (without second tray)

Printing method

Electro-photographic printing using LEDs as light source

Print colour Monochrome

Print speed Letter: 30 pages per minute maximum
A4: 28 pages per minute maximum

Resolution B410d, B410dn: 600 x 2400 dots per inch

B430d, B430dn and B440dn: 1200 x 1200 dots per inch

Operating platform

Windows
2000/XP/XP server 2003 x 64 bit edition/Vista/Vista x 64 bit edition

Mac
0OS X PowerPC (10.2.8 - 10.5) / OS X Intel (10.4.4 - 10.5)
Unix/Linux

Emulations B410d, B410dn: PCL5e, PCLXL, Epson FX, IBM ProPrinter
B430d, B430dn, B440dn: PCL5e, PCLXL, Epson FX, IBM ProPrinter, PS3
Interfaces Parallel port in compliance with IEEE 1284-1994 standard
USB 2.0 High speed
B410dn, B430dn, B440dn: 100BASE-TX/10Base-T
Processor 297 MHz PowerPC
Memory B410d, B410dn: 32MB expandible to 288MB

B430d, B430dn and B440dn: 64MB expandible to 320MB

Printer/Fuser life

200,000 pages or 5 years

Toner life

Starter: 1,500 pages

Replacement: (ISO/IEC19752)
B410d, B410dn: 3,500 pages
B430d, B430dn: upto 7,000 pages
B440dn: upto 10000 pages

Specifications > 76




ITEM SPECIFICATION

Image drum life Simplex printing

25,000 pages (continuous)
20,000 pages (3 pages per job)
12,000 pages (1 page per job)
Duplex printing

15,000 pages (continuous)
13,000 pages (3 pages per job)
10,000 pages (1 page per job)

Paper sizes A4, A5, A6, B5, Letter, Legal 13, Legal 14, Executive, Custom, C5, C6,
Com-9,Com-10, DL, Monarch, Statement

Paper feed B430d, B430dn, B440dn: Automatic feeding via paper trays (including
optional second tray and Multi Purpose Tray)

B410d, B410dn: Manual feeding of single sheets

Paper feed capacity | B410d, B410dn and B430d, B430dn: Tray 1: 250 sheets
at 75g/m2 B440dn: Trayl: 530 sheets

Optional Tray 2: 530 sheets

B430d, B430dn, B440dn: Multi Purpose Tray: 50 sheets
B410d, B410dn: Manual Feed Tray: Single sheet

Paper output Face up, face down depending on paper size, type and thickness

Power consumption | At 22°C

Typical: 450W

Idle: 70W

Power save mode: 7W

Paper output Face down: 150 sheets
capacity at 75g/m2

Monthly duty cycle B410d, B410dn: 50,000 pages
B430d, B430dn, B440dn: 70,000 pages

Consumables Toner cartridge, Image drum
Power cable Approximately 1.8 m max. length (not provided)
Noise level Operation: 53 dB(A)

Standby mode: 30dB(A)
Power saving mode: Background level

Environmental Operation: 10 - 32°C, 20% - 80% RH,
conditions Storage: 10-43°C, 10% - 90% RH

When the printer is stored, it should be in its original packaging, with no
moisture formation.
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PAPER AND TRAY INFORMATION

Feed and ejection methods vary depending on the type, size and thickness of medium used.
Use the chart below and the notes/symbols/terms on the following page for initial guidance.
(Minor variations to settings may be necessary depending on user setup and environmental

conditions).

Feed Ejection
Tray Method
Paper type Size Weight T1 T2 MPT MF FU FD
Plain paper A4 L, ML, M, MH 0 0 0 0 0 0
Letter
A5 L, ML, M, 0 0 0 0 0 0
B5 MH, H
Executive
Legal (13) H 0 0 0 0 0 0
Legal (14)
Statement L, ML, M, 0 X 0 0 0 0
MH, H
A6 L, ML, M, X X 0 0 0 0
MH, H
Custom L, ML, M, MH A A 0 0 0 0
W: 86 - 216 H A\ AN 0 0 0 0
L: 140 - 356
Postcards - X X 0 0 0 X
Envelopes Com-9 - X X 0 0 0 X
Com-10
DL
C5
Cé6
Monarch
Custom
W: 86 - 216
L: 140 - 356
Labels A4 - X X 0 0 0 X
Letter
Transpa- A4 - X X 0 0 0 X
rencies Letter
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Duplex Printing

Auto Manual
Paper Size Wei- T MPT M T1 T2 MPT MF
type ght 1 F
Plain A4 L, ML, 0 0 X 0 0 0 0
paper Letter M, MH
Legal (13) H X X X 0 0 0 0
Legal (14)
A5 L, ML, X X X 0 0 0 0
B5 M,
. MH, H
Executive
Statement L, ML, X X X 0 X 0 0
M,
MH, H
A6 L, ML, X X X X X 0 0
M,
MH, H
Custom L, ML, A A X A A 0 0
M, MH
W: 86 - 216 H X X X AN yAN 0 0
L: 140 - 356
Postcards - X X X X X X X
Enve- Com-9 - X X X X X X X
lopes Com-10
DL
C5
C6
Monarch
Custom
W: 86 - 216
L: 140 - 356
Labels A4 - X X X X X X X
Letter
Transpa- A4 - X X X X X X X
rencies Letter
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NOTES/SYMBOLS/TERMS

Notes:

1. When an optional second paper tray is used, the original tray is referred to as Tray 1
and the optional tray as Tray 2.

2. Itis possible to use custom paper sizes with the PS emulation driver.

3. Tray 1 can accommodate paper with width of 100 to 216mm and length of 210 to
316mm.

4. Tray 2 can accommodate paper with width of 148 to 216mm and length of 210 to
316mm.

5. When printing using Auto Duplex, paper will not be ejected face up.

6. The printing speed is reduced when you set the paper size of A5, A6, Postcards,
Envelopes as Heavy.

7. Label mode must be selected in the printer driver, if you want to print on heavy

media which exceeds 120g/m?.

SYMBOL/ MEANING

TERM

T1 Paper Tray 1

T2 Paper Tray 2 (optional)

MPT Multi Purpose Tray (B430 & B440)

MF Manual Feed Tray (B410)

FU Face Up printing from the rear of the printer
FD Face Down printing from the top of the printer
W, L Width, Length in mm

L Light paper weight: 64g/m?

ML Medium Light paper weight: 64 - 74g/m?

M Medium paper weight: 75 - 87g/m?

MH Medium Heavy paper weight: 88 - 104g/m?
H Heavy paper weight: 105 - 120g/m?2

o Can be used

X Cannot be used

yAN Can be used depending on the size.
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C
Cleaning page .......ccooeevvneenn. 65
E
Envelopes

TYPES i 30
Exit paper jam ........c.c..ceee 68
F
Feed jam or exit jam............. 68
Feed paper jam............ccee. 68
I

Image drum

Replacing.........
Input paper jam
installed options

Macintosh ........ccoccvvviiinnns 38

Windows ......ccovevvvvviiineeennn 38
Installing

Paper ..o 31
installing drivers

Macintosh .......ccoceiiiiinnn. 38

Windows ......coovevviiiinennennen 38
Installing paper..........cccoee. 31
installing Printer Menu Setup

LI Lo ] 38

interface

LED array ......coooeovvenieiiinnennnns 66
LED indicators..........cccvvveneen 12
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